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Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

« Understand it, and identify current problem areas
- Model a new hardware configuration

* Maybe shared ICF and Thin Interrupt?

213 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

» Sysplex Aggregation Pricing eligibility

This session is *not* covering:
- Sysplex concepts -> see the replay of Gene Sale’s excellent session

« zCP3000 basic knowledge — please see the last page for reference urls
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Collecting Model Input Data

Plan the Study

« Any current performance concerns?

 Which CFs matter, and which don’t?

« Should the study include overview information?

« Are any partitions currently sharing channel paths?

 Are *all* of the mainframes (z/OS and CF) co-located? Is the distance
changing?

* |f there Is a standalone CF, what type of machine is it on, what type of
engines is the CF using and how many, and is it sharing?

© 2015 IBM Corporation



Collecting Model Input Data

Capture the *right* period of time,

representative of what you want to do.

- Collect 1 week, maybe 2 if variability is not well understood.

* Assume 24x7 unless proven otherwise

 All members of “production” sysplexes

* If doing link consolidation, useful to include Test/Dev sysplexes.
« CPUMF (SMF 113) helps get the workload characterization right.
« All partitions that belong together as a production group

» Sysplex Aggregation Pricing reports require data for all sysplex members

© 2015 IBM Corporation
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Too Much Datal

2015 Techline testcase:
25 sysids @ 13.7MB average
342 MB of input data

* Use 64-bit CPSJAVA
e Collect one week, not two

* Shut down everything else.

* Increase max java heap size
SET JAVA_OPTS="-Xms2G - Xmx6G*“

(in your C:\cpstools\zCP3000 64-bit dir, then cpstoolstart to start zCP3000)

* Once data loaded, delete I/O, then save 3PA
* Delete uninteresting intervals, then save 3PA

* Ask CPSTOOLS@US.IBM.COM for help

© 2015 IBM Corporation
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Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

« Learn about the data, identify current problem areas
- Modelling a new hardware configuration

» Using shared ICF and Thin Interrupt

« 713 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

« Sysplex Aggregation Pricing eligibility

© 2015 IBM Corporation
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zCP3000 “modes”

PA — Performance Analysis

'# CUSTOMER DATA - ZCP3000 PA Overview (e (=) IS.S

CP — Capacity Planning

File Edit View Action Help Analysis
EBEIE
FCrco6s27 FCPCETTI0 mmem
F ARIEL43 = r ARIEL45— s CASIOST =y i EFCEEEET
" ARIELA3 ==y r ARIELAS ==
ARIEL46 = F ARIEL41 = r CASIO58 = y g g
i * ARIEL4G = = ARIEL 41 ==
- ARIEL42 ==y pHOTOCAR - CASIOS2 ==y P : :
UL
= ARIELQF m— T A SO N * ARIELA2 ===y = NOTOCAR =
A A
* ARIELOF

WCprcees27

= ARIELA3 ==y p ARIEL45 =
g @

= ARIEL46 ==y ¢ ARIEL41 =
g @
ARIEL42 = r NOTOCAR-
ARIELOF =

A

PA — detail on the current, plus alt CPUs

@move partitions, change C@

QM - Quick Migration

CP — workload growth

As of Nov 2014, use QM mode, not
CP mode for sysplex modelling.
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Nov 2014 major changes in zCP3000

As of Nov 2014, use QM mode, not CP mode for sysplex

Why? Heisenberg's uncertainty principle : you can measure this, or
you can measure that, but not both at the same time.

Sysplex modelling function moves to QM mode, so that it can:

e Recalculate service time when the CF moves to a different speed engine.
e Change the dispatch mode to/from dedicated, dyndisp = Off/On/Thin

e Can make multiple configuration changes and still see before vs after.

Unchanged from CP mode:

* Service time recalculation for a cf link type change or distance change.
* Projected service time when moving from dedicated to thin interrupt.

© 2015 IBM Corporation
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Understand the Collected Model Data

View->Physical View->Sysplex Logical
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CF23 and its connections to PLEXIO sysplex members are highlighted at left.
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Select a study interval

Action | Help
View->Physical i LT s View->Sysplex Logical
H Set SDP i
Wcrce6a27 Wepcs7730 Reference Processor  |[2X PLXEXP
 ARIELA3 == p ARIEL45 == sCASIOS3 == pCASIOSHH | Select Interval ¢ @@ @@ ddPPPPPI PP

< i = i GoToC iy Planni fEL43 ARIEL45 ARIEL4G
iﬁz;;?::.w::::ﬂj 1

" ARIEL4G == r ARIEL4 1= rCASIO58 == pr CASIOS5) Append Glossary

A ||A ||A

A
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 ARIEL4 2 === = HOTOCAR = rCASIOS 2 m— e HOTOCART o : :
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Select a study interval

-

"# Select Interval for Study
Action Analysis
Shift
[¥] Prime [v] Evening
Night Weekend
"
H0000 1
40000 1
30000 1
1]
o
= 20000 1
10000
0
.
0 0 0 0 0
D0 a0 0 o0

Include in Graph below selected CPCs and PU types
wlce [JzaaP [JziP [ JICE []IFL
[ ] show LPARs

1149
Mo

EICFSRFE033

BCPC67730
BCPC66827

CPCE682T
CPC&T730
CFSRFEQ33

Date Time

MIP:S

11815 1115

32689

11815 11:30

35188

11815 [11:45

35048

11915 12:00

38440

11815 1215

35038

11815 12:30

35861

11815 12:45

34154

11815 13:00

37233

11815 1315

33571

11815 13:30

33383

11815 13:45

31735

11815 14:00

33562

11815 1415

26822

11815 14:30

24317

11815 |14:45

22063

11815 [15:00

33445

11915 1515

25639

11815 15:30

27902

11815 1545

27770

11815 [16:00

34431

1]

The default is
90t % of

e All shifts
e All intervals
e All CPCs
 GCP used

Cancel

o0
v
4

Upc
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Select a study interval

EEE)

Include in Graph below selected CPCs and PU types
LIcP [JzaaP []zlP ICE [ ]IFL

[] show LPARs

E and below

Include only

119
Mo

EICFSRFE033
B CPCE7730

BCPC66827

CPCG622T
CPCGTT30
CFSRFEQ33

Date

Time

MIPS

11915

11:15

649

11915

11:30

662

11915

11:45

623

11915

12:00

758

11915

1215

685

11915

12:30

GO6

11915

12:45

670

11915

13:00

724

11915

1315

677

11915

13:30

709

11915

13:45

657

11915

14:00

678

11915

14:15

570

11915

14:30

531

11915

14:45

483

11915

15:00

502

11915

1515

493

11915

15:30

521

11915

15:45

467

11915

16:00

537

Jl

Keep

 All shifts

* Allintervals
e All CPCs

Change this:

* Uncheck CP
* Check ICF

e Reselect 90%

Cancel

Update

.
"# Select Interval for Study
Action Analysis
Shift
[¢] Prime [#] Evening
Hight Weekend
0
800
600 +
wn
| B 400¢
200
i
| 1]
I . .
0 0 0 o
A 0 0 0 o
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Look at Collected Model Data

Incomplete Configuration Information

* Red Triangles flag things CPCTDFS ~CPC9634
that you need to fix. il -LP15= £ LP16=) FLP1B=y FLP1CA
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 Standalone CFs will often
need further definition.
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Looking at Collected Model Data

We know this config is not right.

We do not have SMF for this machine.
This is all we know about CF25:

CFTYPE="2097-E12"
CFNCPS="01"
SR="59644"

Plus, we know it must be sharing
ICF/GCP resource with *someone*.

But we don’t even know this is ICF.

This could be an empty ICF partition on
another CEC (check the SR#).

Or, this CEC contains another CF.

Or, this CF uses GCP, which it is sharing

w/ z/OS sysplex members, or z/VM-
Linux, or whatever.

]
s

(This config needs editing.)

" - S, N
¥ Define CPC CFSR59644 e ) S
Eile
Supervisor: |LPAR |«

Interval  |Processorn GCPs|zAAPs | ZlIPs | ICFs | IFLs |PwrSaviChange|
61212 14:...[2097-E12 00/ 00[ 00 10/ 00| [] L] |=
61212 15:...[2097-E12 0.0, 00 00 10 00 [] L]
61312 07:...[2097-E12 00/ 00[ 00 10/ 00| [] L]
6/13/12 08:...(2097-E12 0.0, 00 00 10 00/ [] L]
61312 09:...[2097-E12 00/ 00[ 00 10/ 00| [] L]
61312 10:...[2097-E12 00/ 00[ 00 10/ 00| [] L]
61312 11....[2097-E12 00, 00 00 10 00 [] L] =
61312 12:...[2097-E12 00/ 00[ 00 10/ 00| [] L =
61312 13....[2097-E12 0.0, 00 00 10 00 [] L]
61312 14:...[2097-E12 00/ 00[ 00 10/ 00| [] L]
61312 15....[2097-E12 0.0/ 00 00 10 00 [] L]
61312 16:...[2097-E12 00/ 00[ 00 10/ 00/ [] L] [+

Ca MaxC..
CF... |[CFCC|CFCC [Defa... |ICF (1.0 1) 0.0% Q 0.0f 00

Cancel Apply I
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ZCP3000 CF Analysis

Error Messages Summary

Error messages for CF CF25 I..F - T. ¥ L

=)

A

@ Linktype invalid between CF25 and 5YI2. Please edit.
& Linktype invalid between CF25 and 5Y14. Please edit.

OK

@ Effective #engines indicates shared engines but the partition definition does not reflect this.

CF Window Summary:

CF Information

Link Information

Structure Information

\

(sortable!)

Graph CF1014 on the CF Window

'-“ CF25: Coupling Facility PA Summary

M )

Tee—

View Action Help Analysis
CF Name: CF25
Sysplex Name:  PLEXIO Peer Hame: CF14

CF Machine Type:  2087-E12/700 CF Machine Type: 2097-703
CF Level: 16 CF Level: 16
CF Utilization 0.0%
Engine Type ICF
CF Engines 1.0 Storage Defined: 5,793 mb

Relative Share 100.0% Dump Storage: 2 mb

Effective #engines: 0.0 Storage Available: 5,778 mb
CrCC Busy 8.4%
//" ' \\
" Partition Sysid.  |SubChanne.., CFLinks: | LinkType: | Km [Link Utilizati. ]
CPC7DFE_LP2B|  SYI1 14 % ICB-4 0.0 0.3%
CPCVDFG_LP2C|  SYI3 14 % ICB-4 0.0 0.2%)]
\\ //
CF Study Interval [6/13112 08:00 | » | Link Quick Fix |
l _— o~
W Type Regslsec Md?
DEZ_GBPO CACH 10 0.43 L] -
DBZ_GBP16K0 CACH 16 0 L
DBZ2I_GBEPZ CACH g 0.36 L]
DBZI_GBP3ZK CACH 32 0.27 L]

+ 4+ + 4+ %
I0_RRS_RMDA.. LIST 3 053 L]
[0_WAS_ERROR LIST g 0 L]
SYSTEM_LOGS... LIST g 0 L] E

\QVC:TIZI..'I NPE | 12T 23 043 1 pra
/
| 22 Structires—_|Totals \ 274 §7.0 duplexed| *
SS— — i
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Fix the CF Link Types

&

+ InfiniBand links come in looking alike, ™ tinvaid Lnks for icFoMA01

and the distance is not known: Invalid CF Links for
CF name ICFOMAO1
CECID CPCB8TFT
Partition Sysid: SubChannels: CF Links: Link Type: Machine t... 2827-713
MN1_PRODM 0151 56 g IC
MN2_PRODMZ 2151 56 g CIB
MN1_PRODM3 3151 56 g IC
MNZ_PRODM4 4151 56 8 CIB Select CPC, distance, and then linktype
MN1_PRODMS 5151 56 8 IC Select CPC: CPC885FT - 2827-706 - | |
MN2_PRODME 151 56 g CIB
MN2_CMCA CMCA 56 g CIB Km Distance: CPC887F7 to CPC88.. o.of |
MN2_CMC3 CMC3 56 g CIB .
MN1_CMCA CHMCa £ 5 To Valid types for CPC885FT @ 0.0km |IFB3-12x -
MN1_PRODMK PRK1 56 8 IC IFB3-12x
] ] ] Click on row to change the Iinlm.rpelFm'“
CF Study Interval  |5/28113 11:00 | " ' —
— CPC Partition | Sysids SUtlFE"lK
Structure Tvpe Size Reqalsec CPC88..| CMCA | CMCA L : S -
DSNDMOG_GBPO CACH 445 7 CPCB88..| FIRA FIRA 28 4 ] 0
~~~~~~~~~~~~~~ TR R --| |cPces..| FDOD | FDOD 28 4 cIB 0
« Why? To model changes, you must |
understand what you are changing from. Reset || Apply || Cancel
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Sysplex Topology Report

Sysplex : PLXEXP

Z/05:COMIL

Z'05EXP3

Z/O5EXPS

“ ARIELOF

Z/05TC02

Z/05:.COM2

Z'OSEXP4

Z/OSEXP6

ZOSEXPT

Z/05.TC04

“ DIONEOF

“ CASIOOF

The PLXEXP sysplex
for this configuration
is comprised of 9
z/0S systems and 3
coupling facilities,
residing on 3
different processors.

Graph PLEX1007 on the Logical Sysplex Window

x s

Processor

Partition
Tvpe

(#) Link
Tvpe

CPCoo827
2827-723

CE

AFRIELOF

(3} IFB3-1x
(4 IC

SYS

EXP3

(4 IFB-1x
(3»1FB3-1x
(4 IC

3Y3

COonil

(4 IFB-1x
(3»IFB3-1x
(4 IC

3Y3

TCo2

(4 IFB-1x
(3»IFB3-1x
(4 IC

SYS

EXP3

(4 IFB-1x
(5»IFB3-1x
(4 IC

CFSRFEQ33
2098-E10

CF

DIONEOF

(4 IFB-1x

CPCoT7730
2827-722

CE

CASIOOE

(3} IFB3-1x
(4 IC

3Y3

EXP4

(4 IFB-1x
(3»IFB3-1x
(4 IC

3Y3

COona2

(4 IFB-1x
(3»IFB3-1x
(4 IC

(4 IFB-1x
FVIERT 1+
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CF Health Check

A single report giving a
summary view of several key
performance metrics.

WARNING (RED) is a strong
indication of a problem.

indicates
a potential problem.

OK (GREEN) means that the
analysis didn't find a problem.

Red or Yellow means that we think you
should look further at this area. It does
not mean there *is* a problem.

Graph CF1000 on the CF Window

(||
i

[}

s

‘ Health Check Analysis for CF25 I

CF Processor]

Structures

SubChannels

Elwmng
Ocaution
Dok
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CF Health Check — CF Processor

e Partition Utilization

CF Processor

 Effective Engines >= 1*

 Current Technology?

* Dynamic CF Dispatch*

* Special logic for Thin Interrupt

Graph CF1000 on the CF Window
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CF Health Check-Structures

Lock Contention

Lock Requests that had to wait

Fix in the Application.

False Lock Contention

2 locks hash to the same index

Increase the Structure size.

Graph CF1000 on the CF Window

'-'ﬂ CF Health Check Analysis : zCP3000 Graph and Text: CF1000

|

File Action

: Structures
i| There were 157 structures in CF21. Looling at data from all intervals, the busiest structure was
IXC2, a LIST tvpe struciure, with an average rate of 2,148 01 requesis per second. Requests
from all 157 structures totaled 7,125 73 per second, on average. Approximately % of all
requests to INC2 were from svstem SYEL1. The table below shows some general information
about activity to different structure types on the CF21 coupling facility.

Structures Average Reqg/sec

LOCE 11 27451
LIST et 3.841.4
CACH 56 5302
Al 157 T.125.8

L

Structures Rule 1 - Lock Contention - Caution
The table below shows information about lock structures. Af least one lock structure had an
interval where Lock Contention exceeded 2. 0%, High Lock Contention can result in an increase
in utilization and reduction in throughput. If the total request number is trivial, high Lock
Contention percentage is not a problem. Otherwise. vou may want to check the other
applications that are running on the systems. In some cases. batch applications that share the -
databases with online applications hold locks for a much longer time. The time that the lock is
held by the batch program can be shortened by taking more frequent checkpoints.

Structures Type Average Irl-:l-n]i False I.-l_:l-r.:]-:

Reqgisec Contention Contention
DEZ2F LOCE1 OWCE 19323 1.84%% 0.21%4%
IGWLOCE DD IL'D-CK. o2 16.05% 0.54%
DE2ZF. LOCE1L ILCI-CK 0.9 1.73%% 0.35%%
IRLMATLCOHCED IL'DCK 4537 0.02%% 00024
DLILOCEKR ILCI-CK 0.0 0.00%% 0005
DE2T _LOCEKI1L ILCI-CK 82.5 0.39%% 01294
DE2E LOWCE1 ILCI-CK 3.6 0.55% 0124
ISGLOCE. IL'D-CK 2719 1.88%% 048724
DE2WV_LOCEL IL'D-CK. 0.2 1.20%% 0.22%%
DLILOCKE IL-D-CK 0.0 0.00%% 0004
DLILOCE IL'DCK 0.0 0.00%% 0.00%
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CF Health Check - Subchannels

Subchannel Utilization
should be very low (<10%)

Sync -> Async Conversion SubChannels
z/OS looked at the on-
ramp and decided to go
with Plan B.

Subchannels Offline
there Is a sustained
pattern of path busy.

Delayed Requests
more than 10.0% of
requests were delayed

SubChannel Busy
Path busy at the hardware
link level.

Graph CF1000 on the CF Window
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Service Time

From when z/OS issues a CF request to when
the return is recognized by z/OS.

e Host Hardware
* Link Latency
e Data Transfer

* CF Busy

Does not include queue time.
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Service Time

« z/OS wants to run all requests
synchronously (except for XCF).

* Insufficient bandwidth or slow service
will cause it to convert to async.

» Therefore, except for IXC requests
and distances>1km, all async requests
should be viewed as a lack of resource.

* Service Time graphs available from
the CF window, the Link window, and
the Structure detail window.

Graph CFLO12 on the CF Link Window

i
[}
b

26

24

I

2

20

18

Service Time {usec)
=] ] = =

[--]

PRODCF1 to SYSB Synchronous Service Time

I3f2EiI |3f28| ISBUI I4f1 ,
, Tu . Th , sa ., Mo |

413

:We

—The Rest
—IMSP_V_BRHS0100A
IMSP_V_RHO00100A
ISGLOCK
—IM3SP_OSAM
—IMSP_IRLM

Interval
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|dentify key coupling links

Suppose there are 2 plexes, with 5 CFs and 20 z/OS members.

Given the objectives of the study, which CFs are important?

Sort the links by request rate (CF window, click on column header)

Look at the CF Structures Report to see which links are busiest for
the busiest (aka most important) structures.

If anything shows up yellow in the Subchannels part of the CF
Health Check, it's worth looking at.
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CF Structures Report

» Use to identify the busiest
structures.

» Use to identify the key CF
links for the busiest
structures.

In your customer deliverable
« focus on critical applications
» focus on identified problems

* otherwise, use this to identify
Important structures and links.

Graph CF1010 on the CF Window
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Service Time for Important Structures

* Pick a busy structure.
* Note which links are busiest.

« Are most requests running
synchronously?

« Are they getting good service
time?

 The IC links to SYSA and the
ICB-4 links to SYSB are
adequate to the current demand.

i
[}
b

’-! PRODCFL : IMSP_IRLM : Structure Detail

e i[=]

o S| |

Sysplex Name

CF Name

Study Interval 2013-04-02 11:00:00 01:00:00 % of CF Utilization 0.0%

ISPLEXP

PRODCF1 Duplex Secondary  Structure Type

Structure Name IMSP_IRLM

|

Analysis

LOCK

SYSA SYSB SYSY SYSF

CF Link Type |IC ICB-4 Iz ICB-4
Requests per Second

Synchranous S5YSA 5YSB S5YSY S5YSZ |

Average 60,717 .1 38,0076 0.0 0.0 =

Maximum 158.181.9 78,8516 0.0 0.0

Study Interval |88,759.9 44 599.0 0.0 0.0 =]
Asynchronous SYSA 5YSB S5YSY 3YSZL |

Average 0.3 2.6 0.0 0.0 1=

Maximum 241 7932 0.0 0.0

Study Interval |0.2 0z 0.0 0.0 =]
Service Time (microseconds)

Synchronous SYSA 5YSB S5YSY S5YSZ |

Average 4.5 9.9 0.0 0.0 1=

Maximum 6.9 12.0 0.0 0.0

Study Interval (5.4 0.8 0.0 0.0 =

Asynchronous SYSA SYsSB STSY SYSL |

Average 60.2 65.8 0.0 0.0 |

Maximum G636.2 1,847.5 0.0 0.0

Study Interval |56.4 404 0.0 0.0 =
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Sysplex Graph Recommendations

Probably in every study
« zCP3000 main view : Topology

CF Migration Summary report

» Sysplex Logical window : Sysplex Topology, Link Summary
« For each CF : CF Summary, CF Health Check, QM only

PA Mode
PA and QM Mode

Look for areas of interest  « cF Link Summary, Link Migration Comparison
 Thin Interrupt Effect e Service Time for Synchronous Structures

» CF Structures Table e Request Rate by System over Time

* CF Link Topology e Request Rate by Request Type and System

Drill down in areas of interest
» CF Logical Utilization over Time

» Advanced CF (shared ICF)

» Subchannel Busy

» Synchronous Service Time (Link)

Lock Contention % of Requests
Synchronous Intensity

Delayed Requests

Busiest Structures with Queue Time

i
[}
b
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Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

 Learn about the data, identify current problem areas
- Modelling a new hardware configuration

» Using shared ICF and Thin Interrupt

« 213 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

« Sysplex Aggregation Pricing eligibility

© 2015 IBM Corporation
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Modeling configuration changes

CF utilization changes w/ the speed of the CPC or alt.

zCP3000 calculates new service times for config changes
« For each structure, link, and sys

« Additional adjustment based on current service time (the crappiness
factor).

« Recalc Sync/async on the new service time.

Service time recalc is triggered in QM mode when:

 Linktype or distance changes
« CF machine type changes via drag and drop
» CF Dispatch mode changes

The current configuration must be understood:

* Link types

 Link distance

« Shared channel paths

« CF model, engine type, and LPAR weight

© 2015 IBM Corporation
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Coupling Links

Responsiveness depends on
* Type of Request
« Amount of data being carried*
How request will be executed (sync or async)
Simplex or Duplex
Path busy or anticipated path busy (queued request)
Link latency
Link speed
Link distance
CF speed and responsiveness
z/OS speed

Service time does not include queue time.
-> see CF Health Check, Subchannels, Delayed Requests

Sysplex Overhead is dependent on
» How request will be executed (sync or async)
« Service Time, for synchronous requests

* (not measured)

© 2015 IBM Corporation
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So lets model a new z13...

Collect data for all sysplex members (and maybe dev/test).

Fully define the sysplex in it’s current state in PA mode.
What *type* of IFB links: IFB3, IFB-12x, or IFB-1x?

Link distance, if it will be changing

|dentify link any chpids shared by z/OS partitions.

For standalone CFs : model, engine type, and LPAR weight

Add hardware feature codes, if possible.

Maybe generate some reports, like the Health Checks for key SYS and CF

Save then go to QM mode.
e Addanewzl13

* Move partitions to the new CPC —> service time recalc
e Define engines and lpars of the new z13 —> service time recalc
* Upgrade link types —> service time recalc
* Change dispatch mode —> service time recalc

Look at the CF Migration Report >

© 2015 IBM Corporation
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CF Migration Summary Report

Before and after comparison of:
e CF configuration summary, CF link utilizations

* Configuration summary for all CFs and z/OS members of the sysplex

Svsplex PLXEXP Configuration After Migration

CECID Model Partition | SCPLevel | Logical Engines | Relative Weight | Engine Tvpe
DIONEOF newZ13 2064-701 || DIONEOF 16 1 Dedicated Engines ICF
COMI CPC663827 || 2827723 | ARIEL43 || ZV011300 2 1.6% GCP
* Key Structures
Configuration Before Migration | Configuration After Migration
Structures Type |Duplexed? |Reqs/sec Service Time Service Time

CQSTMSGQ

%Sync

Svnc

Async

LIST No 88.7% 214 57.0 88.7% 246 448
ISGLOCK LOCK No 9,700.3 99.9% 15.3 56.1 100.0% 142 O
IXCLSTO1 LIST No 5,071.4 0.0% - 61.7 0.0% - 56.5
DB2DS0S_LOCK1 |LOCK No 2,285.5 98.1% 15.1 443 100.0% 143 O

Graph CFQ100 on the CF Window (QM only)

i
[}
b
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Change the CF machine type

Step 1 — add the new machine

Add » CPC

Rename | Hew Sysf

-CPC7C8B5 - Add 5_:5 "#] AddacPC =

[F”"—”PD3—HFDG"" AddaNell Name [newCEC
Processor |(2827-701 b

TE 5TE1 TE 5T1 TE 5T3

[ _”. “ \ Supervisor

U STM PRODCF1 TESTCFH Ok Cancel

[ _” “ -‘ [ & A

USTACF1 USTACF2

Iy I ) —
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Change the CF machine type

Step 2 — move some partitions there

.\ CPCTCSCS [m,',{-ﬂf- The new CPC will still be marked in
* PROD2 == p PROD4 == ¢ PRODG2 = error because the definition needs
& > &
b lw —‘ E‘u p A to change to accommodate the
_ / partitions that just moved there.
[ TEST2 g 1 TEST4 sy 1 [J STAG ey 7
o o . |
| J : / Drag PRODCF2 and o
‘ — / TESTCE2 to newCEC ot
rUSTA2 == r PRODCF2 p TESTCF2| mnm TF*-:T:‘F::
il [A } A -‘
»USTACF2+

Figure 4. CEC Definition needs to be fixed
on new CPC.

Figure 3. Error due to empty CPC

'@ Configuration differences will cause CF request service times to be recalculated. Edit->Undo to reverse this change.

© 2015 IBM Corporation
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Change the CF machine type

Step 3 — define real engines and partitions

"# Define CPC newCec I é@g

—

File
Supervisor: | | Zaap On Ziip
Interval Processor GCPs IAAPS ZlIPs IFLs Pwr3av Change

4113 10:00 2827-H20 1.0 0.0 0.0 o) 0 [ ] -
4113 11:00 2827-H20 1.0 0.0 0.0 A Field to End L] v
4113 12:00 2827-H20 1.0 0.0 0.0 0. Row to End L]
41113 13:00 2827-H20 1.0 0.0 0.0 0 : L] =
41113 14:00 2827-H20 1.0 0.0 0.0 oy All Eield ]
4/1M13 15:00 2827-H20 1.0 0.0 0.0 0.1 All Row L] -

Mame CllPgm | Workload | Wkld Type | Type | Mo | Weight | Weight% | Cap | Abs Cap | MinCap | MaxCap
PRODCF2 |CFCC  |CFCC Default ICF 1.0/ € 90l 0.0%| [] 12528 13920
TESTCF2 CFCC CFCC Default ICF 1.0 10( % 0.0% g 1392 1382.0

Cancel Apply
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Change the CF machine type

If necessary, upgrade the coupling links.

"# DIONEOF: Coupling Facility QM Summary =B X

View Action Analysis

CF Hame: DIONEOF
Sysplex Name: PLXEXP

CF Machine Type:
aEF":_:,gEe "#] Graph Selection _1 ; > l E_M

Lpar Utilization 7.8% E-L0ul4 S Feeiy-Saalnan
Engines (1 CFQ100 CF Migration Summary
—mr

Dynamic Dispatch CFTrTo SEStperatrres
Relative Share 50. CF1026 Structure Execution Time
Effective #engines: 1.8 CF1027 Thin Interrupt Effect on Synchronous Execution (wiAlts)
CFCC Busy 8.4% CF1028 Thin Interrupt Effect on Synchronous Service Time (wiAlts)

[ ] Favorites Sel All Doc All Show

Farfition SY3I0D;
ICPCEBE2T .. COM1
|F3F'CE?T3EI... COM2 603.4 23 4 IFB-1x 0.0 3.3%
ICPCERB2T .. EXP3 12,3252 28 4 IFB-1x 0.0 3.1%

Otherwise, you're done,
generate a CF Migration Summary for each major CF.
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CF Coupling — Relative Link Speed in zCP3000

zCP3000 Name Link type
ISC3 ISC3
IFB-1x IFB 1X
IFB-12x IFB 12X —z9
IFB-12x IFB 12X
ICB4 ICB4
IFB3-12x IFB3 12X —z114
IC IC-z10 BC
IFB3-12x IFB3 12x —zBC12
IC IC-z9 BC
IFB3-12x IFB3 12X
ICA CS5
IC IC-z9 EC
IC IC-z114
IC IC-zBC12
IC IC-z10 EC
IC IC-z13
IC IC-z2196
IC IC-zEC12

Link latency
(mics)

12

10

8

3.5

3.5

3.5
3.5

O ™ YO Sy S Gy SN

Link speed
(Mbs/sec)
200
400
600
1000
1500
2500
3200
4000
4000
5000
5000
5000
6500
7100
7500
8500
8900
9400

Supported on

z13,zBC12,zEC12,2114,2196,210,29,2990,2890,2900,z800

z13,zBC12,zEC12,2114,2196,210
29
z13,zBC12,zEC12,2114,2196,210
210,29,2990,2890

z114

z10-BC

zBC12

29

z13zEC12,2z196

z13

29

z114

zBC12

z10

z13

2196

ZEC12
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Coupling Links

To model a link type change:

(estimate new service time)
F_
U

|

pgrade Link [

':ﬂ CUSTOMER DATA - zCP3000 PA Overview

File Edit View | Action | Help

« Must be in QM Quick Migration Mode [ [ ] ey roon R
(CP MOde |S belng phased OUt) \ E:ferencercessur
. . < GuTogllckhigmtlu_nJ
« One CF-SYS set of links at a time [ Rppomr oy "
‘ U@
[ARIEL46 = [ ARIEL41—

 |f CEC model change also, do that first.

(||
()
i
||‘|||
]|

s
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Change the Coupling Links

*# DIONEOF : COMLI : Edit CF Link Type

I><

Double click a link

Analysis

O n th e CF Wi n dOW to Sysplex Hame PLXEXP Machine Type
SYSID COMA1 2827723
IOOk at the ||n k CF Name |DIONEOF 2964701
. CF Study Interval [2015-01-19 10:00:00 00:15:...
d eta I I . ~ Link Configuration ~ Shared Links
Configuration Bef... Current @ Chpids ' Adapters
Machine Type 2098-201 2064-701
o ” ;
U se t h e U pg ra d e Link Type IFB-1x IFB-1x = Shared-L Chpids SYSID
v 4 COMA1
Minimum adapters 2 2 v 4 TCO2
button to model a | 7 T
Chpids 4 El v] 4 EXP5
new ||nk type. Subchannels 28 28
Distance({km} 0.0 0.0
Utilization Before Current
CF 28.5% 13.3%
Sysid 15.5% 15.4%
Subchannel 2.3% 2.3%
Requestsisec Before Current
Sync 22294 818
Async 584.63 T38.77
Total 817.57 817.57
Semvice Time (usec) Before Current
Sync 203 15.1
Async 100.64 825
Average 7873 75.76
Upgrade Link || Edit H Cancel || Apply |
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Change the Coupling Links

-Link Configuration {"  Upgrade |
Configuration Bef... Current
Machine Type 2098-201 2964-701 2864-701
/v@grade LinD > =
Minimum adapters 2 2 |
Chpids 4 E -
Subchannels 28 28 ==
Distance({km) 0.0 0.0
28
LUtilization Before current !"'Estimated l! 0.0 |
CF 23.5% 13.3% 13.3%
Sysid 15.5% 15.4% 15.5%
Subchannel 2.3% 2 3% 0.2%
Requestsizec Before current Estimated
Sync 22294 81.8 22503
Async 594 63 T3IRTT 592 54
Total a17.57 817.57 817.57
Senvice Time (usec) Before Current Estimated
Sync 20.3 151 8.449
Async 100.64 825 7924
Average T8.73 7576 59.?‘?'1‘
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Changing the Coupling Links

We already changed the CF machine type.
Now we’re changing the link type.

LUtilization Hefore Estimated
CF 13.3%
Sysid Rk L 15.5%
Subchannel 2 3% 2 3% 0.2%

Fequests/sec Before Estimated
SyYNC 22294 . 225.03
Async 794.63 . 9254
Total 817.57 . 817.57

Senvice Time {ua&cﬂ Before Estimated
Sync 203 . 8.49
ASYNC 100.64 . 79.24
Average f8.73 . RA.TT

© 2015 IBM Corporation



CF Link Migration Comparison

senvice Time (usec) Before Current Estimated

Sync | 203 15.1 [ 8.49

Async L100.64 825 1 79.24

Average 78.73 {5.76

Service Time (usec)
Structure LaSvonchronous
Type Reguests/sec Svnchronous Asvnchronous
Duplex Before Afiter Before After Before Afiter
IXCLSTO1 LIST 5025 0.0%% 0.0%% 0.0 0.0 10:0.5 792
ISTGENERIC LIST 143.0 08.6% 100.0%% 220 02 156.9 204
ISGLOCE LOCE 78.1 100.0%% 100.0%% 17.1 7.2 0.0 275
IRRXCF00_P001 CACH 3.7 06. 7% 100.0%% 239 0.8 122.4 30.1
OPERLOG LIST 0.2 035.0% 100.0%% 201 g2 68.2 204
Total/'Weighted Average 817.6 27.3% 27.5% I 203 8.5 ﬂ [ 100.6 792

* The Total/Weighted Average will agree w/ the Request Activity Summary on the Link Window.
e All structures have better sync service time, and better yet, more requests will run

synchronously.

* le, currently 3.3% of IRRXCFOO_P001 requests run asynchronously w/ a service time of 122.4
microseconds. After the z13 and IFB3 migration, those 3.3% will run synchronously w/ a

service time of 9.8 mics.

Graph CFQLO01 on the CF Link Window (QM only)

© 2015 IBM Corporation



Heuristic Sync->Async Conversion

Approximate Threshold for Conversion
« zOS keeps a table of observed CF

service times for each structure. z2/0S Host Microseconds
- Depending on the estimated efficiency z3-EC 2094-701 36.92
tradeoff, it may convert any synchronous 29-BC 2096-201 44.65
operation to asynchronous. 210-EC 2097-701 26.00
« Conversion is done *before* the request 210-BC 2098-201 31.27
Is ever launched. 2196 2817-701 26.00
* Requests converted this way are async z114 2818-701 26.45
from the start. They do not count as a JEC-12 2827-701 26.00
changed” request. 7BC-12 2828-701 26.00
 With 10 mics added per km distance, 713 2964-701 26.00

anything over 2km will certainly be async.
Table 1. The meaning of “slow”

Note: This is COMPLETELY DIFFERENT from subchannel busy
sync->async conversions.

© 2015 IBM Corporation
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Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

 Learn about the data, identify current problem areas
- Modelling a new hardware configuration

* Using shared ICF and Thin Interrupt

« 713 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

« Sysplex Aggregation Pricing eligibility

© 2015 IBM Corporation
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Effective number of engines

F T - ™
"#] Define CPC CFSR59644 Y Y R
Calculated as: -
File
(CF Busy + CF Wait) Supervisor: [LPAR |+
Interval time Interval  |Processorn GCPs|zAAPs | zZIIPs | ICFs | IFLs |PwrSav|iChange
6M2M12 14: | 2097-E12 0.0 0.0/ 00/ 10 00 [] Ll |=
6M2M215:..12097-E12 0.0 0.0/ 00[ 10/ 0o [] L]
6M13M1207...|2097-E12 0.0 0.0 00 1.0/ 00 [] L]
6M3M208...|2097-E12 0.0 00 00 1.0/ 00 [] L]
When EFECP < Defin P 6M23M2 09 12097-E12 0.0 0.0 00 1.0 00 [] L]
€ ¢ efined CPs 6M123M1210:..|12097-E12 0.0 0.0/ 00[ 10/ 0o [] L]
6M23M211...|2097-E12 0.0 0.0/ 00[ 10/ 0o [] L] i
6M13M1212:..|12097-E12 0.0 0.0 00 1.0/ 00 [] L]
H t 3 6M3M213...|12097-E12 0.0 0.0/ 00[ 10/ 0o [] L]

I:'> SharEd Englnes 61312 14:.|2097-E12 0.0 0.0 00 1.0 00 [] L]
6M23M2 15 |12097-E12 0.0 0.0/ 00[ 10/ 00 [] L]
6M3M216:..|2097-E12 0.0 0.0/ 00[ 10/ 0o [] Ll |+
MNa...|CHP...| Cate...|Cat T...[Type| Mo |Park.. | Wei...[Weig...| Cap .. ..
CF... |CFCC|CFCC [Defa... [ICF (1.0 1| 0.0% Q 0.0 0.0

* 5 . .
Probably. Something else is using some of that ICF
If effcp>90%, it could be LP mgmt. (Or GCP) I
Cancel Apply
L —
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Shared vs Dedicated CF Engines

Why is this still so important?

*Typically low CF utilization
* Newer engines are usually faster

* Need to stay within one generation of z/OS hardware

- hard to justify dedicated engines

© 2015 IBM Corporation
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Enhanced Methods for sharing CF engines

Dynamic ICF Expansion z10 and below only
allows a CF patrtition to have *both* shared and dedicated ICF engines.

Dynamic CF Dispatch (for the test/dev CF)
CF gives up control of the processor when there is no more work to do.

Thin Interrupt (for test/dev and maybe some prod)
link hardware generates an interrupt when something arrives in the link buffer
PR/SM can quickly dispatch a shared engine CF with new work,
and the CF will drop when work is done.

Testcase : the effect of losing Dynamic ICF Expansion
before : 1 dedicated and one share ICF in production, one shared ICF in non production on z10

after : 2 shared ICFs in for production, one shared ICF for non-production on z196

© 2015 IBM Corporation
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The effect of sharing ICF engines

Synchronous Service Time on CF11 I

157

Service Time (usec)

z10 + ICB4 + Dyn_ICF_Expansion

(||
i

5

[T

.-||i

T

s

144
131
121

111

-
=

=]

6M1
Mo

612
Tu

613
We

Synchronous Service Time on CF11 I

—The Rest

— DB2E_GBP1
DB2E_LOCK1
DB2P_GBP1

—VSAMCACHE

—DB2P_GBP3

618
Mo

540 1

504 4

468 1

432 1

396 1

[
=]
=

Service Time (usec)

180
144 4
108 1

?2-

36 i

619
Tu

-
T
g~
—

620
Ve

621
Th

—The Rest

—DB2P_GBP1
TQSGAPPLICATION1
PQSGAPPLICATIONA

‘} —VSAMCACHE

i

—DB2P_GBP3

1
3 4 2

z196 + IFB12x + shared engines
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“Regular” Sharing

Both CF1 and CF2 have DYNDISP=0OFF (default setting)

Default LPAR Time Slice : 12.5 - 25 ms

%\ Work Work Polling for work

F1

Default LPAR Time Slice : 12.5 - 25 ms

Work Work Polling for work

A CF Busy CF Wait

2 LPAR Time Slices (~ 50 ms)
Difference in Scale
microsec (sysplexOp) vs millisec(LPAR slice)
CF Busv + CF wait EFFCP =~ 0.5 engines
EFFCP= | y )

Interval time

"I"III
il
i

: |i
I

®

—

CF (LPAR) Utilization = 17.5%
CFCC Busy = 35%
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Dynamic CF Dispatch

CF1 has DYNDISP=OFF & CF2 has DYNDISP=ON

Default LPAR Time Slice : 12.5 — 25 ms Default LPAR Time Slice : 12.5 -25 ms

CF1 Work  Work Polling Work  Polling Work  Work Polling Work  Polling

CF2 goes back to sleep.

For CF1.:
__ : What happens
EFFCP =~ 0.85 engines to this Lock
CF (LPAR) Utilization =45% request ?
CFCC Busy = 56%

© 2015 IBM Corporation
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Thin Interrupt

Both CF1 and CF2 have DYNDISP=THININTERRUPT

Work is done. Go to sleep. Poll for work. Nothing to do. Go to sleep.

\/
AN - - - I - -

Work II Work Work I

Work is done: go to sleep.

CF2

~T=—Nn

‘-__l-

New work arrives

© 2015 IBM Corporation
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Impact of Thin Interrupt

Average Asynchronous Service Time by Coupling Facility

T00 -

DYNDISP=0ON

300

microseconds

200

100

03222094-  D3242014- 032472004 032472014 03252014 0226:2014- 03252094 13262094 03262014-  032672014-  032T2094-  CEATR04-  CEITR014-  D3RER014-  03EE20M-  032873014-
23.45.00 07.00.00 15.00.00 2200.00 070000 150000 23.00.00 07.00.0g 15.00.00 Z200.00 07.00.00 15.00.00 220000 07.00.00 15.00.00 220000

* Frank Kyne, Share Session 15602: The Skinny on Coupling Thin Interrupts
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Shared vs Dedicated CF Engines

The Bottom Line Is

Dedicated engines are still recommended
for production workloads for best responsiveness, reliability, and availability.

If the CF is always dispatched, it’s always looking for new work.
Interrupts would not provide any response time benefit .

If ICF resource will be shared,
* All sharing CFs should set DYNDISP=THININTERRUPT

* LPAR weights & engines can be used to give more to the needy.

© 2015 IBM Corporation
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So how can zCP3000 help?

Can identify service issues due to
« shared CF engine in current configuration
« old technology, or too great a difference

Can identify issues that more/faster ICF won't fix
e Lock contention
e Subchannel busy
* Poor service time due to slow links

CF1027 report to compare service time dedicated vs Thin Interrupt.

More changes zCP300 in 2015 to
« CF Dispatch modelling (not just dedicated -> Thin)
« 2/OS effect of Thin Interrupt

© 2015 IBM Corporation
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Dedicated -> Thin Interrupt

Thin Interrupt performance

View Action

CF Hame:
Sysplex Name:
CF Machine Type:

CF Level:
Lpar Utilization
Engines
Dynamic Dispatch

Relative Share

CASIOOF

PLXEXP
2827-722
19

13.6%
{1) ICF

Dedicated Engines

for sync will be similar, a

little bit worse for dedicated.

Peer Name: ARIELOF
CF Machine Type:

"# Graph Selection

CF1014

Facility Summary

CFQ100

igration Summary

F Structures Table

=Structure Execution Time

Thin Interrupt Effect on Synchronous Execution (

Thin Interrupt Effect on Synchronous Service Tin

[ | Favorites | Sel All Doc All
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CF1027 Effect of Thin Interrupt

17.5

15.0

—
b

—
e

o

5.

Average Sync Service Time (usec)

Table 1. Synchronous Service Time (microseconds)

E42827-722 + Thin Interrupt
Bl 2827-722 + Dedicated Engines

Current Configuration | Thin Interrupt
Structure | Duplex

2§17-721 2§27-721

DBIDSOE GEP4 | * 16.4
DBIDSOE GEP2 | * 146
DBIDS(E GBP1O| * 13.6
DBIDS(E GBP4S| °* 15.8
DBIDSOE GEP3 | * 143

]
s
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Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

 Learn about the data, identify current problem areas
- Modelling a new hardware configuration

» Using shared ICF and Thin Interrupt

« z13 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

« Sysplex Aggregation Pricing eligibility

© 2015 IBM Corporation
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Coupling Link Connectivity

IC

ISC-3

ICA SR
HCA3-O LR (1x)
HCA3-0 (12x)
HCA2-O LR (1x)
HCA2-0 (12x)
HCA1-O (12x)
Max ext Links

Max chpids

(||
i
[}
s

z13

256

Max Supported Coupling Links

zEC12
32
48
n/a
64
32
32

32

104
128

Link = Port ,

zBC12*
32
32
n/a
32
16
12
16
n/a
72
128

2196

32
48
n/a
48
32
32
32
n/a

104

128

z114*

32
48
n/a
32
16
12
16
n/a

72

128

1, 2 or 4 ports per adapter

z10
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Coupling Link Configuration

Max Adapters Ports per Recommended

Fanout (Features) Adapter chpids/adapter
ICA SR (z13) PCle 16 2 8
HCA3-O LR (1x) GX++ 16 4 8
HCA3-0 (12x) GX++ 16 2 8
HCA2-O LR (1x) GX++ 16 2 8
HCA2-0 (12x) GX++ 16 2 8
ISC-3 (zEC12) 48 1 1

In zCP3000, link = CHPID

© 2015 IBM Corporation
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z13 Link Migration problem

zEC12 / 2196 Book
Z13 Drawer

GX++
GX++
GX++ X X

g 4 | GX+t+ PCle | PCle | PCle | PCle | PCle
GX++

GX++
GX++ | J | | ]
4

LL_GX++ | 5

PCle | PCle | PCle | PCle | PCle

+ o+ 30
+ + X0
+ + >0
+ o+ O

[,

Configuring the same number of IFB coupling links on z13 as on
2196/zEC12 may require additional CPC drawers

© 2015 IBM Corporation
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s this an actual problem?

Use eConfig to determine the current installed adapters.
Define a new z13, then configure adapters.
zCP3000 will tell you how many books on the new machine.

r oy F -
'-.! Hardware Feature Codes A ‘l == \_*M "# Hardware Feature Codes g w ph Pe H@M
Analysis
CPCEGE2T
newZ13
4 Books Chpids Chpids i )
_ 2 Drawers Chpids Chpids
FC#  Adapter LinkType 2827-H89 Normal Max FCi e s 206463 Normal Max
0172 ICA ICA 0172 ICA ICA 0o - 0 0
0171 HCA3-0  IFB-12x B = 16 32 0171 HCA3.0 IFB-12x L 48
0170 HCA3-OLR IFB-1x 2 16 32 0170 HCA3-OLR IFB-1x 2 — 16 32
0163 | HCA2-0 [FB-12x 0 0 0 0163 HCAZ-O IFB-12x
0168 |HCA2OLR [IFB1x 0 — 0 0 0168 HCAZOLR IFB-1x
0162 HCA2-C  Ficon 0 = 0 0 0162 HCA2L Ficon 0 E 0 0
! o167 Hcato B N R
3393 ICB4 ICB-4 3393 KB4 ohicd
0217 I1SC-3 ISC-3
017 ISC-3 I1SC-3
0218 I1SC-3 I5C-3
0218  ISC-3 1SC-3
Cancel Apply
Cancel
Pull an eConfig report for the existing system to find the installed feature cod...

© 2015 IBM Corporation
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What if it is a problem?

* Adopt the new ICA coupling link for z13-z13 links.
* Prioritize GX++ slots for 1x distance coupling
* Eliminate FICON Express8 (also uses GX++)

 Eliminate or consolidate Infiniband links

4 chpids per port for 12x,
8 chpids across 4 ports



Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

 Learn about the data, identify current problem areas
- Modelling a new hardware configuration

» Using shared ICF and Thin Interrupt

« 213 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

« Sysplex Aggregation Pricing eligibility

© 2015 IBM Corporation
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CF Link Consolidation

Prior to InfiniBand and ICA
* One link = one chpid = one feature

« Alink could be shared because the chpid could be shared, between
members of the same sysplex on the same mainframe, going to the
same CF

With InfiniBand and ICA

« The physical link can carry multiple chpids

« Chpids can be from the same sysplex or a different one

« Each chpid can still be shared by partitions on the same mainframe
going to the same destination CF

7CP3000 Termi nology IFB-1x : 8-16 chpids on 4 ports on HCA2-O LR or HCA3-O LR
IFB-12x : 8-16 chpids across 2 ports on HCA2-O or HCA3-O
IFB3 : max 4 chpids per port(2) on HCA3-O

 Link = channel path (chpid)

« Adapter = the physical path

© 2015 IBM Corporation
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CF Link Consolidation

* Typically multiple physical ICB4 or ISC3 links/adapters/chpids

 Often chpids are shared between 2-3 partitions

* Meaning you really have (chpids/partitions) number of ICB4 links.

 Minimum two HCA2-O or HCA3-O adapters
« Meaning that each machine will have 16-32 channels paths

* IFB3 Is a protocol, not an adapter, requiring
« HCA3-O adapter types on both ends
« Maximum 4 chpids per port

IBM recommends

» One for one replacement of non-IFB chpids with IFB chpids

« Many to one replacement of non-IFB adapters with IFB adapters

© 2015 IBM Corporation
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Incomplete Configuration Information

Red Triangles mean
something is not fully
understood.

~CPCTDF6 =CPC9634
=LP25= FLP26= =LP2C= | | FpLP15= pLP16=) pLP1B=y pLP1C=

=
-]
S N |
m

]

« Currently, all InfiniBand chpids come in
with channel type “CIB”.

,
Ed 3 |[E

]

: —
= 2 |

]

,
C 2 |CH

]

L |
& S

[ |

,
3 |E

]

: —
= s |

q

>
&4 2 |[E

]

' —
& S

|

LP27= pLP28= rLP2D= rLP2E= | | FLP17=y pLP1S= pVM11 FVI12-

- Correct the current link definitions before
proceeding:

+ Link type LP2F= pLP23= rLP24= V219 | | Fvm13 pvmt4 pym1s-IBEF11

* Shared CHPIDs?
» Distance, for remote CFs

&4
&
&4
=
=
=
4

WCr1a—

=
|
—
Pacd
(]
I
=
-_—
—
]
(]
[ |
L |
=
|
—
Pad
=
1
=
-_—
—
]
tn
[ |

=
=
=
>

« With CFCC 18, RMF will be able to
differentiate various IFB link types and
Detect if CIB link running "degraded* Werz1—lCrs— -

Linux
CFSR509G644

CF25
* Not yet supported in zCP3000 *
‘ A \

>
[
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Sysplex CF Link Summary Report

Summary of Links by CEC

CEC Summary

Minimum
. Defined Configured Minimum
Processor ID Link Tvpe: Link CHPIDS Adapters Recommended
Adapters
IC 4 2 n'a n'a
CPCTCSE3
ICE-4 3 3 ) 3
IC 4 8 n'a n'a
CPCTCARCS
ICE-4 8 3 g 3
Processor CPCTCSBS
SR# TC3BS
Partition CE/SYSID Sysplex OpSys CF Links

@)1

0Dl STS5A SPLEXP =08 1.11.0
(I ICE4
@HIC

ODCF1 ODCF1 SPLEXP FCC Level 16
4 ICE4
(2)IC

0D3 SYST SPLEXP /05 1.11.0
(2)ICB-4

Graph PLEX1008 on the Logical Sysplex Window

(||
]

1
I
-lli
M
b
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Shared Channel Paths

This is where
subchannel busy

SYSA happens.
\ i
SYSB _/. 7 shared
| | subchannels

|IOCP Definition of a shared cf link:
CHPID PATH=(CSS(0),F4),

i|||i|||
b

SHARED,
PARTITION=((SYSA,SYSB),(=)),
PCHID=101,

TYPE=CFP

CF1

© 2015 IBM Corporation
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Multiple CHPIDs on a single InfiniBand Link

CEC1 CEC2

SYSA

] Single InfiniBand cable

SYSEB [

- n -
, |14 unshared subchannels | CF1
»i

» This InfiniBand link carries 2 unshared chpids.

» Because the chpids are unshared, you should not see subchannel busy
here.

* It connects a port on an HCA2-O adapter on CEC1 to a port on an

HCAZ2-O adapter on CEC2. There is room for up to 6 more chpids on
this cable.

© 2015 IBM Corporation
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Shared Chpids and Shared HCA3-O Adapters

CEC1 CEC2

SYSA Single PSIFB cable CF1
D\. 4 channel paths ../D
2 unshared chpids
D *m ..\‘D CF2

SYSB

CF3
D\. 2 shared chpids
(=™

SYSC

* This InfiniBand link carries 4 chpids. You still have room to define up to 4 more
on this port. There is also a 2" port for each HCA2-O adapter, not shown.

« SYSA has one chpid each to CF1 and CF2; SYSA patrtition is not sharing

these chpids with any other z/OS system on CEC1. The CF1 partition sees 1
chpid, and the CF2 partition sees 1 chpid.

« SYSB and SYSC each have one chpid defined to CF3. SYSB and SYSC each
have 2 chpids to CF3, but they are shared. CF3 sees 2 chpids.

i|||i|||
b
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CF Link Consolidation — Shared CHPID

.k Sysplex Lab2 ISC3 - zCP2000 PA Overview

=,

- =0k

3l A
= F )]
A

= SUP== = SUP3= CFO6 =11

=CF01 =

>

File Edit View Action Help Analysis
BE
=CECTB92 =CECTBAZ B
=PRO== rPRD2=y rPROG= =PRD3= rPRD4=y rPRDS= ||
=PRD7= FREDA= #CD1D= =PROE= ED-F’: =X T 2=
8l (s
=CADF =y INT1 ==y - PRO D= =PROE= rPRD9=y = SUP4=
ul
[ CF05=—
A

1]

2 or more partitions on the
same CEC

« talking to the same CF on
another CEC

« same sysplex
* using the same chpid
- same type (ISC3, ICB4, IFB)

CHPID PATH=(CSS(0),F4),SHARED,
PARTITION=((DEVJ,DEV1,DEV2),(=)),
PCHID=101,TYPE=CFP
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Defining Shared Channel Paths

-~

*#] CFO5 : P1DF : Edit CF Link Type

M=]X]

Help Analysis
Sysplex Name PLEX01 Machine Type
Sysid P1DF 2097-732
CF Hame |CF05 2097-732
CF Study Interval |2010-06-16 11:00:00 01-...
Link Configuration Shared Links
Current @® CHPID () Adapter
Link Type InfiniBand-12x ShareELinks Chpids Sysid
¥ B P1DF -~
Minimum # FCs 2 L] B P20F
Chpids 6 T
Subchannels 42 |
Distance(km) 0 =
Utilization Current
Coaoupling Facility 32.3%
Sysid 56.1%
Subchannel 5.5%
Requestsisec Current
Sync 148.73
ASYNC 31,047.75
Total 31,196.48
Service Time (usec) Current
Sync 54.06
Async 747
Redefine Current Link H Cancel H Apply |

i
[}
b

You have to do
this yourself

CP3000 does not know if
a link is shared.

You *may* be able to tell
from the CF
HealthCheck.

Shared Links table lists
the partitions that could
possibly share these 6
chpids.

CF linktype must be fully
defined and must match
exactly.
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Defining Shared Adapters

= O3

|-F'RD—

|-F'RD?-

||
o 2|8

T
s
==
=

SUP =

3
C1DF = |-
55

o]la

|
il
=
=1}

p

F'RD3-‘ |-F'RD4-

A

lo]o]o

EXT2

_I

rmwmg_

suP4

=

A

CFUE—‘ |-EF[I1—

“# sysplex Lab2 ISC3 - zCP3000 PA Overview /BR - z...
File Edit View Action Help Analysis
EE
=CECTB92 =CECTBAZ
= DR DG PRDS

CFO4—
&
Jl

| | ]

EDF data for the sysplex master gathering svstem is missing.

« 2 Or more partitions on
the same *pair* of
CECs

» talking to any CF on
either CEC

« same sysplex, or not
* using different chpids

« which run through the
same IFB pipeline.
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Defining Shared Adapters

‘#] CFO5 : P1DF :

Edit CF Link Type

=JOES

Help

Link Configuration

Sysplex Name PLEXO01

Sysid |P1DF

CF Hame (CF0S
CF Study Interval [2010-06-16 11:00:00 01:...

Current

Machine Type
2097732
2097732

Shared Links

i) Logical (® Physical

Analysis

Link Type InfiniBand-12x Shared ...| Chpids Sysid | CF Mame|Sysplex ...
G| P1DF CF05 | PLEXO1 |=~
Minimum # FCs 2 L] G P4DF CF04 | PLEXOZ
[ ] G| PADF CF01 PLEX02 | _
Chpids ] [ ] G| PBDF CFD4 | PLEx0Z2 |
[ ] G| PEDF CF01 PLEX02 | |
Subchannels 42 ] G| P7DF CF01 PLEX0Z
L] G| P3DF CF06 | PLEXO1
Distance(km) 0 ] 6| P20DF CF05 | PLEXOT [
Litilization Current
Coupling Facility 32.3%
Sysid 56.1%
Subchannel 999990 0%
Fequesisisec Current
sync 148.73
Async 31,047 .75
Total 31,196 .48
Senvice Time (usec) Current
3ync 54 06
Async 4.7
Redefine Current Link Cancel Apply

i
[}
b

InfiniBand only

Shared Links table lists
the sysplex members and
CFs on these 2 CECs
that could run on the
same physical InfiniBand
feature.

*NO* performance
Implications.

P2DF could be *both*
logical share and
physical share.
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Defining Shared Adapters

"# Cro5 : P1DF : Edit CF Link Typeu.
'S L R

ET)

Help Analysis
Sysplex Name PLEX01 Machine Type
Sysid P1DF 2097-732
CF Name [CFO5 2097-701
CF Study Interval | 2010-06-16 11:00:00 0...
Link Configuration Shared Links
Current ) Chpids ® Adapters
Link Type IFB-12% Shared-P| Chpids | Sysid |CF NameSysplex ...
v G P1DF CF05 | PLEX01 |~
Minimum adap... 7 ] G| P4DF CF04 | PLEXDZ
v] G| PADF CF01 | PLEXDZ | _
Chpids 6 v] G| PaDF CF04 | PLEX02
v G| PGDF CF01 | PLEXDZ2 |
Subchannels 42 v 6| P7DF CF01 | PLEX0Z2
v G| P3DF CFOG | PLEXO
Distance(km) 0.0 ] 6 P2DF | CF05 |PLEXD1 |4
Utilization Current
Coupling Facility 32.3%
Sysid 56.1%
Subchannel 5.5%
Requests/sec Current
Sync 14873
Async 31,047 .75
Total 31,196 .48
Senvice Time (usec) Current
Sync 54.06
Async 747
Redefine Current Link H Cancel H Apply |

« 54 chpids running on 54
ISC3 links...

Replace with

* 54 chpids running on 7
IFB adapters.
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Defining Shared Adapters

CF Link Topology Report
PLEXO1:CFO05:P1DF

CHPID
Sharing

The P1DF system on CEC7B92 shares 6
chpids to the CFO5 coupling facility on
CEC7BA2 with O other partitions.

Adapter
Sharing

i
[}
b

54 chpids share 14 ports on 7 InfiniBand
HCAZ2-O adapters.

ProcID CECTBA2

2097-732

z/OSP3DF

Z/OSEXT2
z/OSPRDE
z/OSPRD9
z/0S8:5UP4
A CF03

A CF01

ProcID CECTB92
2097-732
2/0SP1DF
— z/0SP2DF
8 chpid
2 ports
2/0S:P6DF
IFB-12x
8 chpid
2 ports z/0SPTDF
IFB-12x
8 chpid z/05PADF
2 ports
1FB-12x Z/O5:CD1D
8 chpid
2 ports
2/08:C1DF
IFB-12x
8 chpid
2 ports Z/OSINT1
IFB-12x
8 chpid Z/0SPRDD
2 ports
IFB-12x 2/08:SUP
6 chpid
2 ports
2/0S:SUP3
' CF06
A CF04
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Agenda

Use zCP3000 to look at sysplex questions:

* Collect the right data for a study

 Learn about the data, identify current problem areas
- Modelling a new hardware configuration

» Using shared ICF and Thin Interrupt

« 213 Link Migration Considerations

* Link consolidation on InfiniBand and ICA

« Sysplex Aggregation Pricing eligibility
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Sysplex Aggregation Pricing

Be a hero

Show your customer how to save
money on software licensing fees.

© 2015 IBM Corporation



Sysplex Aggregation Pricing

100 1

Pay for software as if it was
executing on a single
large CPC.

801

601

s MSU %

LMY

4]
T

AR

F.
T WLLLLLCCECECECECEUUCCCUCRCECRCRCCRCREE

I CPC IEP‘UMﬂdEl I{:apacily{MEU} IP‘ricingPlEI I icing MSU &

ICPCQ'&E:I I 2007-703 I 312 PLEXPO 628
ICP‘C?‘DF&I 2007-703 I 316

z/0S sysplex members use more
than 50% of the machine.

Graph PLEX1005 on the Logical Sysplex Window
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Sysplex Aggregation Pricing

1001

Sysplex members must use more than 50%.

Not currently eligible, but what 801
If the z/OS in partition COP2
moved to CPCE7C5?

IVS MSU %

I ICPT_T Model IEap:u:ih‘ (MST) IPri{:i.ﬂgPlEI IPrl'{:'mg MSU
ICPEFEEE I 2094-7035 I I"‘*Iu:!-t Eligible I

IEPEE"EJ I 2097-706 I I"‘*Iu:!-t Eligible I

IEPE-‘lE—"LIE- I 2817-604 I I"'*In:!-t Eligible I

Use PlexCalc tool to verify qualification.

COoP2 CoP1 COoP3
CPCF36C CLPZ CLP1
Graph PLEX1005 on the Logical Sysplex Window CPCETCS CPCACAS
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Reference Slides

)M z Systems
he innovation continues




Sysplex Graph Recommendations

Probably in every study
« zCP3000 main view : Topology

CF Migration Summary report

» Sysplex Logical window : Sysplex Topology, Link Summary
« For each CF : CF Summary, CF Health Check, QM only

PA Mode
PA and QM Mode

Look for areas of interest  « cF Link Summary, Link Migration Comparison
 Thin Interrupt Effect e Service Time for Synchronous Structures

» CF Structures Table e Request Rate by System over Time

* CF Link Topology e Request Rate by Request Type and System

Drill down in areas of interest
» CF Logical Utilization over Time

» Advanced CF (shared ICF)

» Subchannel Busy

» Delayed Requests

Synchronous Service Time (Link)
Lock Contention % of Requests
Synchronous Intensity

Busiest Structures with Queue Time

i
[}
b
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Index to recommended Graphs

zCP3000 main view Structure Window

* INV1012 Topology - STR1015 Lock Contention %
zCP3000 sysplex view
« PLEX1007 Sysplex Topology
« PLEX1008 CF Link Summary
« PLEX1005 Sysplex Aggregation CE Link Window
CF Window |
« CF1014 CF Summar - CFLOO5 CF Link Topology
CF1000 Health Check Analysis

CEQ100 CF Migration Summary report * CFL001 CF Link Summary
CF1027 Thin Interrupt Effect

« STR1017 Synchronous Intensity

CF1010 Structures Table « CFQLOO1 Link Migration Comparison
CF1001 Logical Utilization over Time o
CF1020 Advanced CF Utilization * CFLO12 Synchronous Service Time

CF1017 Subchannel Busy

CF1015 Delayed Requests

CF1012 Service Time for Synchronous Structures
CF1009 Request Rate by System over Time
CF1004 Request Rate by Request Type and System
CF1016 Buslest Structures with Queue Time

© 2015 IBM Corporation
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Need help?

Engage Global Techline

E B Em
IEEEE

=z Techline System Design & Configuration

ot
Geography
|North America EI [ Go! ]
CPS Tools for System z Capacity Planning
Capacity Planning Support (CPS) tools are used| Request Submission
IBM System z processors. These tools are fre]| @@= Technical Sales Reauest Generator
Groups to discuss issues, ask questions, and ¢
-5 eMail Techling o

The Sizing and TCO Analysis Tools page lists several restricted acces:

discern the total costs of ownership. The Fit For Purpose Assessment
that it will be running.

EJ engage help to run any of these tools, contact Global TechlinEI

Program WebPage Download User's Guide
ZSOFTCAP % Download ®] Download
vd. 3d 07/23/2013 07/23/2013
ZPCR & Download &l Download
v8.4a 09/23/2013 07/23/7013
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zMasters slide decks and replays:
Will be posted to TechDocs in late June.

15602: The Skinny on Coupling Thin Interrupts

https://share.confex.com/share/123/webprogram/Session15602.html

CPSTools Education & Downloads available at:

IBM - http://w3.ibm.com/support/americas/wsc/cpsproducts.html

BPs - https://www-304.ibm.com/partnerworld/wps/serviet/ContentHandler/tech PRS1762

Contact: cpstools@us.ibm.com
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http://w3.ibm.com/support/americas/wsc/cpsproducts.html
https://www-304.ibm.com/partnerworld/wps/servlet/ContentHandler/tech_PRS1762
https://share.confex.com/share/123/webprogram/Session15602.html

Thank you!

The 1NNovation continues




